# Table of Contents

1 General 4
   1.1 User Login 7
   1.2 Layout of the main dialog 9
   1.3 Menu and Tool bars 10

2 Logbook 13
   2.1 Message list 13
   2.2 Filtering messages 15
   2.3 Activating alarm mode 19

3 Personnel Management 20
   3.1 Device status 20

4 Reports 23
   4.1 Reports: Page view 23

Index 27
1 General

Access PE is an Access Control System which has been designed to offer the highest standards of security and flexibility to small and medium sized installations. Access PE owes its stability and upgradeability to a 3-tier design: The top tier is the administration level with its controlling services. All administrative tasks are carried out here, e.g. the registration of new cards and the assignment of access rights.

The second tier is formed by the Local Access Controllers (LACs) which govern each group of doors or entrances. Even when the system is offline a LAC is able independently to make access control decisions. LACs are responsible for controlling the entrances, governing door opening times or requesting PIN-codes at critical access points.

The third tier consists of card readers which, like the Controllers, are identical across all BOSCH access controls. They provide not only a consistently high degree of security, but also a simple upgrade and expansion path for the system, protecting previous investments.

Access PE multi-user version allows multiple workstations to control the system. Customizable user rights levels regulate access and guarantee security. In this way it is possible, for example, to maintain card data from one workstation whilst using another to verify whether an employee is present in the building.

Access PE offers exceptionally flexible configuration of access rights, time models and entrance parameters. The following list gives an overview of the most important features:

**Quick & Easy card Assignment**

Cards (up to three) can be assigned to persons either manually or using a dialog reader connected to a PC via a serial connection. Only one card can be active per person at any one time. When upgrading cards the old card is automatically overwritten and becomes invalid, thus preventing old cards
from gaining access even if those responsible forgot or were unable to cancel them.

**Access Rights (including Group Privileges)**
Each person can inherit group privileges as well as having individual rights assigned to him. Privileges can be restricted by area and time to an accuracy of one minute. Group privileges can be used to grant and limit access rights for any or all cardholders simultaneously. Group privileges can be made dependent on time models which restrict their access to certain times of day.

**Access tracking**
By defining Areas it is possible to track and enforce a correct sequence of accesses. Even without monitoring, this configuration makes it possible to display a cardholder's location.

**Anti-Passback**
When a card has been read it can be blocked for a defined period from entering at the same access point. Hence it is possible to prevent "passback", where a user hands his card back across a barrier to provide access for an unauthorized person.

**Automatic Cancelation of cards upon Expiration**
Visitors and temporary staff frequently require access for a limited period only. cards can be registered for a specific time period, so that they automatically lose their validity when that period expires.

**Time Models and Day Models**
A cardholder can be assigned to specific time models which regulate the hours in which that person has access. Time models can be defined flexibly using day models which determine how specific weekdays, weekends, holidays and special days deviate from normal working days.
Identification via PIN-Code
Instead of a card a person can use a special PIN-Code to enter.

Verification via PIN-Code
Particularly sensitive areas can be programmed to require additional PIN-Codes. This protection can in turn be made dependent on time models, so that, for instance, a PIN-Code is only required for access during holiday times or outside of defined working hours.

Flexible Door Management
Flexible parameterization of individual door models allows an optimum balance between security and comfort. The "shunt" or alarm suppression period can be individually specified to regulate for how long a door may remain open. In cooperation with an alarm system the access point can then optionally be locked.

Periodic Door Release
In order to facilitate access, door alarms can be shunted to release doors for specific periods. Door release periods can be defined manually or automatically via a time model.

Time and Attendance
Access points can be parameterized to record ingress and egress for time & attendance purposes.

Card Design
The graphical add-in module Card Personalization (CP) is fully integrated into the Access Control system to allow the operator to create cards without switching applications.

Assignment of Photos
If the add-in module Card Personalization (CP) is not activated photographic identification can nevertheless be imported and associated with cardholders.
**Offline locking system**
Areas which are not covered, for whatever reason, by the high-availability online access control system can nevertheless be locked offline.

**Administration of video devices**
Entrances can be equipped additionally with cameras to identify and track the movements of persons using them.

### 1.1 User Login

Start the **Logviewer** application using the desktop icon or via **Start > Programs > Access Professional Edition > Logviewer**.

The system’s applications are protected from unauthorized use. A login with a valid **username** and **password** is required in order to invoke the dialog-based subsystems.

The upper drop-down list can be used to select the desired interaction **language**. The default is that language which was used to install the application. If there is a change of user without restarting the application then the previous language is retained. For this reason it is possible for a dialog box to appear in an undesired language. In order to avoid this, please log in to Access PE again.

Access PE applications can be run in the following languages:
If a valid username/password pair are entered then the button **Change Password** appears. This can be used to start a new dialog to change the password.

The button **Start the application** checks the user's privileges and, based on these, starts the application. If the system is unable to authenticate the login then the following error message appears: **Wrong username or password!**

**Login via Personnel Management**

If the user is already logged into the Access PE **Personnel Management** application, and if the user's rights include **LogViewer**, then **LogViewer** may be invoked directly using the
button in the tools list, without requiring a separate login to the LogViewer application.

### 1.2 Layout of the main dialog

1 = **Menu bar** - Contains all dialog functions arranged in menus.
2 = **Tool bar** - Contains the most important dialog functions as icon buttons
3 = **Title bar** - Conforms to Windows standard and contains buttons to minimize and close the main dialog window. The name of the current user is displayed in square brackets.
4 = **Device status** - List of the configured devices and entrances along with their connection status.
5 = **Message list** - List of messages arrived hitherto. The display can be modified by specific filter settings.
6 = **Filter selection** - Predefined and customized filters can be selected from the combo-box.
1.3 Menu and Tool bars

The following functions are available for log evaluation via menus and icon buttons.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
<th>Icon button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Print...</td>
<td><img src="image" alt="printer" /></td>
<td>Print the log messages displayed</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
<td>Closes the LogViewer application.</td>
</tr>
<tr>
<td>Menu</td>
<td>Function</td>
<td>Icon button</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------</td>
<td>-------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Filter</td>
<td>Filter definition</td>
<td></td>
<td>Opens the message filtering dialog.</td>
</tr>
<tr>
<td></td>
<td>Continuous mode on</td>
<td></td>
<td>Starts continuous message display. This icon is only active when the function is not already running and the message filter is set to the current day. Continuous message display is the default setting.</td>
</tr>
<tr>
<td></td>
<td>Continuous mode off</td>
<td></td>
<td>Pauses the continuous message display. This icon is only active when continuous message display is running.</td>
</tr>
<tr>
<td></td>
<td>Events previous day</td>
<td></td>
<td>Switch to previous day's messages.</td>
</tr>
<tr>
<td></td>
<td>Events next day</td>
<td></td>
<td>Switch to next day's messages.</td>
</tr>
<tr>
<td>View</td>
<td>Symbol bar</td>
<td></td>
<td>Hides/Displays the tool bar. Default = on.</td>
</tr>
<tr>
<td></td>
<td>Status bar</td>
<td></td>
<td>Hides/Displays the status bar. Default = on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>without a menuitem</td>
</tr>
<tr>
<td>Menu</td>
<td>Function</td>
<td>Icon button</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------</td>
<td>-------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>? (Help)</td>
<td>Help topics</td>
<td>[Help icon]</td>
<td>Opens this help file.</td>
</tr>
</tbody>
</table>
2 Logbook
All processes (including, for example, login and logout data for users at a workstation) in the Access PE access control system are forwarded using corresponding messages and stored in the event logs. You can separate security-related messages (alarm messages) from purely information-related items by classifying them; this makes it easier for you to implement any further measures that may be necessary.

For a clear presentation with the option to filter important messages and alert dialog users, you can install and start the LogViewer dialog on any workstation, provided that the user rights of the person who is logged in allow this.

2.1 Message list
The main function of LogViewer is the display of log messages both current and historical.

By default the display is continuously updated with incoming messages. The relevant icon buttons appear with the following statuses:

Upon startup of LogViewer the current day's messages are displayed. The messages from previous days can be displayed using the button. A log file with the filename format **Msg<yyyyymmdd>.log** is created every day in the following
directory C:\BOSCH\Access Professional Edition\Data\MsgLog. All such files can be displayed in LogViewer.

The message list contains columns with the following information:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(no title)</td>
<td>Symbolic representation of the message category as defined in Configurator.</td>
</tr>
<tr>
<td>(no title)</td>
<td>Identification of the messages for which a video recording exists:</td>
</tr>
<tr>
<td>Date</td>
<td>Date and time when the message was created.</td>
</tr>
<tr>
<td>LAC / PC</td>
<td>Source of the message: name of the controller or workstation.</td>
</tr>
<tr>
<td>Reader / Login</td>
<td>Source of the message if the controller has only forwarded the message. If source is a workstation then the name of the workstation user.</td>
</tr>
<tr>
<td>Location (Door) / Program</td>
<td>Name of the entrance, signal or other installation. If a workstation then the name of the application.</td>
</tr>
<tr>
<td>No.</td>
<td>Message number as per the list of event log texts in the Configurator.</td>
</tr>
<tr>
<td>Message</td>
<td>Message text as defined in Configurator.</td>
</tr>
<tr>
<td>Card-No.</td>
<td>card number (in as far as it was readable and known to the system).</td>
</tr>
<tr>
<td>Last name</td>
<td>Surname of the cardholder.</td>
</tr>
<tr>
<td>First name</td>
<td>First name of the cardholder.</td>
</tr>
</tbody>
</table>
The message list can be customized as desired. For example, the order of columns can be changed by dragging and dropping the column headers. Thus you can give prominence to those columns you consider most important.

In order to find the messages that interest you more effectively, the list view allows you to **sort** (toggling ascending or descending order) by double clicking on any column header.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company / Dept.</td>
<td>Company / Department of the cardholder.</td>
</tr>
<tr>
<td>Local date</td>
<td>If the AMC is located in a different time zone, then the local creation time for the message is shown here.</td>
</tr>
</tbody>
</table>

**NOTICE!**

Depending on the user's assigned rights the messages displayed will be more or less limited. For users who are only entitled to view own messages, all messages pertaining to other persons will be filtered out. For users who are not entitled to view any personnel data the last four columns of the contents will appear blank.

### 2.2 Filtering messages

To restrict the display to messages matching specific criteria, click **Filter > Filter Definition** or the icon button in the tool bar. A dialog for choosing filter criteria will be opened.
You can filter messages according to the following criteria:
<table>
<thead>
<tr>
<th>Filter criterion</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time period from ... to...</td>
<td>By entering dates here it is possible to restrict the display to a certain time period. The current date can be entered as latest date. By entering other dates displays of events from past dates you can change or expand upon the data already displayed.</td>
<td>Because all log files will be read it is unwise to specify a very long period for the display. Depending on the size of the log files we recommend a maximum of one month in total.</td>
</tr>
<tr>
<td>Name</td>
<td>The display can be limited to persons whose names match the filter criteria.</td>
<td>The filters <strong>Name</strong>, <strong>Company/Dept.</strong> and <strong>card</strong> must be used singly and can not be used in combination.</td>
</tr>
<tr>
<td>Company/Dept.</td>
<td>The display can be limited to persons from specified companies or departments.</td>
<td></td>
</tr>
<tr>
<td>card</td>
<td>The display can be limited to persons whose card numbers lie within a specified range. E.g. all card numbers beginning with 6.</td>
<td></td>
</tr>
<tr>
<td>Entrances</td>
<td>Limits the display to those messages concerning specified entrances.</td>
<td></td>
</tr>
</tbody>
</table>
Saving and reloading filters

To avoid having to redefine filters at every restart of the program LogViewer allows each user to store and reload preferred filter settings. After defining your personal filter settings you can store them by clicking **Save...** at the bottom of the dialog box. By default named filter settings (**<filename>.flt**) are stored in **C:\BOSCH\Access Professional Edition\Data\Cfg**

<table>
<thead>
<tr>
<th>Filter criterion</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messages</td>
<td>Limits the display to certain message types.</td>
<td></td>
</tr>
<tr>
<td>Alarm siren with .wav file</td>
<td>Alarm Messages can be emphasized by playing an acoustic signal. Any system audio files can be selected to accompany an alarm.</td>
<td></td>
</tr>
</tbody>
</table>

**NOTICE!**

A filter is only active as long as the application is running. Default settings (i.e. current day, no filtering) are restored as soon as LogViewer is restarted.
Saved filter settings can be reloaded and activated by picking them from the Filter combo-box in the bottom left corner. To check and/or edit a previously defined filter, first load and open it by clicking and then Load... on the Filter view dialog.

The loaded filter settings can now be verified, modified and finally applied to the running application by clicking OK.

2.3 Activating alarm mode

By clicking Activate alarm, or by selecting a saved filter with alarm activation, the LogViewer window is closed and goes into standby mode. It appears in the Systray as the icon . Upon mouse-over the following text is displayed Access PE: Wait for alarm. By double clicking the icon the dialog window can be brought back into the foreground at any time.

**NOTICE!**

As long as Alarm mode is active the application can not be closed by the x button in the title bar, nor by File > Exit. Instead LogViewer returns to standby mode.

If a message is received then the main window is brought back to the foreground.

As long as the Sound Off box has not been checked the incoming alarm will also be accompanied by an acoustic signal.
3 Personnel Management

3.1 Device status

Situated next to the list of log messages is the device status display.

The following symbols reflect device status:

- Controller is online.
- Controller is offline.
- Connection to the controller can not be determined.
- Extension board is online.
- Extension board is offline.
- Connection to extension board can not be determined.
- Connection to entrance - OK.
- Connection to entrance is faulty.
- Connection to entrance can not be determined.
Entrance is locked.

Entrance is open / open long-term.

Entrance is open too long / possible intrusion.

Connection to reader - OK.

Connection to reader is faulty.

Connection to reader can not be determined.

---

**NOTICE!**
The status display of Wiegand readers can be misleading. Because they are not able to respond to status requests a parameterized Wiegand reader is shown as online as long as its controller is online.

---

**Controls**
This function is only active when the user logged in has **door control rights**.
Selected entries in the device status list to which there is a connection can be given commands via the context menu (right click) or the menu **Door management**

<table>
<thead>
<tr>
<th>Open Main entrance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long-term open Main entrance</td>
</tr>
<tr>
<td>lock Main entrance</td>
</tr>
</tbody>
</table>

The name of the selected entry is read from context.

**Open <Entrance>**  
The selected entrance opens once (for one person).

**Long-term open <Entrance>**  
The selected entrance opens for a longer period.

**Lock <Entrance>**  
The selected entrance is locked.
4 Reports
You can use the list functions in Access PE to collate the database contents in a specific way and organize them into a clear format for printing.
To filter the results so that only the data the user needs to see is shown, you can use pre-prepared layouts, which provide specific information regarding a certain aspect of access control (for example, who has what authorizations for which doors).

4.1 Reports: Page view
Open log files can be saved or printed. The menu item File > Print or the button opens a preview.

NOTICE!
All opened log files will be printed.
Close all files which should not be printed or reduce the selection to the important messages.
The reports page view offers a number of tools for modifying and manipulating the display:

<table>
<thead>
<tr>
<th>Button</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Export" /></td>
<td>Export</td>
<td>The list can be exported to a file for further processing. The following formats are available: Acrobat Portable Document Format (PDF) Comma Separated Values (CSV)</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print</td>
<td>Prints the report via a print dialog which allows the setting of a default printer.</td>
</tr>
<tr>
<td><img src="image" alt="Select page" /></td>
<td>Select page</td>
<td>The arrow buttons turn to the first, previous, next or last pages of the report. The control also shows the current and the total number of pages in the report.</td>
</tr>
<tr>
<td><img src="image" alt="No. of pages" /></td>
<td>No. of pages</td>
<td>Prompts the current page and the number of all pages.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom" /></td>
<td>Zoom</td>
<td>The standard scale of the view (100%) can be changed as desired.</td>
</tr>
</tbody>
</table>

**Exporting lists**

Press the ![Export](image) button to open a dialog for defining the export criteria.
The **Format** selection list field offers the output formats .pdf (for forwarding and archiving specific search results) and .csv (for further processing data).

When exporting data to a csv file, it can be processed to some extent on the way.

As well as entering the **Delimiter** and the export **Mode**, you can also exclude or isolate **Report and Page sections** (column headers and page details) and **Group sections** (selected data) from the export.

You can select one of the following options as the **Destination**.

- **Application** – opens the file with the appropriate application. This application must also be installed on the computer. pdf files are opened with Adobe Acrobat Reader and csv files are opened with MS Excel.
- **Disk file** (default) — opens an Explorer dialog for selecting the directory you require. A name for saving the file is suggested.
- **Exchange folder** — the file can be sent directly to an MS Outlook recipient.
- **Lotus Domino Mail** — the file can be sent directly to a Lotus Mail recipient.
Index

A
alarm mode 19

E
event 13, 19

L
layout 9

M
message 13, 15
message filtering 15
message list 13

P
password 8

R
reports export 24
reports preview 23

S
system 4

T
toolbar 10

U
user login 7